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1.0 Quick Start Guide 

RemoteCall offers a simple way to host a remote session and connect with another user via the internet. 

Note: This quick start guide assumes you have already setup a User ID and password through 

www.remotecall.net. 

Just follow these 3 simple steps to setup RemoteCall and get connected. 

1. Installing the RemoteCall Viewer 
2. Launching a Remote Support Session 
3. Connecting with the Remote PC 

 

Step 1: Installing the RemoteCall Viewer 

1. Visit the RemoteCall home page (http://www.remotecall.net) 

2. Select the Support menu and click [RemoteCall Viewer] from the Downloads section. 

3. Run the executable file and follow the on-screen instructions (for detailed installation instructions, please 
refer to the “Installing RemoteCall Viewer” section of this manual). 
 

 
                        Fig [1-1] Quick Start - Viewer Download 

 

  

http://www.remotecall.net/
http://www.remotecall.net/
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Step 2: Launching a Remote Support Session 

1. Double-click the RemoteCall icon on your desktop 

2. Login with your User ID and password 

 

        Fig [1-2] Quick Start – RemoteCall Login 

 

3. A session will start automatically, displaying the connection URL (Relay Page) and session code. 

 
      Fig [1-3] Quick Start – Viewer Launch 
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Step 3: Connecting with the Remote PC 

From the remote PC: 

1. Visit the Relay Page (http://rsup.net) 

2. Install the ActiveX control when prompted 

 

       Fig [1-4] Quick Start – ActiveX Install 

 

3. Enter the session code and click [Connect] 

 

    Fig [1-5] Quick Start – Relay Page Session Code 

http://rsup.net/
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Fig [1-6] Quick Start – Representative Interface 

Fig [1-7] Quick Start – Customer Interface 
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2.0 Welcome to RemoteCall 

RemoteCall allows you to remotely connect with and support any PC connected to the internet. You can view the 

remote user’s desktop in real-time and even take full mouse/keyboard control. To check your account settings and 

permissions before logging in, visit the RemoteCall Admin page at www.remotecall.net and login. 

 

2.1 How to use this guide 

This guide is broken up into 6 main sections: 

1. Quick Start Guide (1-1) 
2. Welcome to RemoteCall (page 1-1) 
3. Installing RemoteCall Viewer(page 2-2) 
4. Connecting with the remote PC (page 3-3) 
5. Support Features and Tools (page 4-4) 
6. Settings and Session Management (page 5-5) 
7. FAQs and Troubleshooting (page 6-6) 

 

2.2 What is RemoteCall Viewer? 

RemoteCall Viewer is the application end of RemoteCall used by the support representative to host a 

remote session and connect with customers. RemoteCall uses an intuitive interface that makes supporting 

as easy as possible, increasing efficiency and customer satisfaction. Simply launch the RemoteCall Viewer 

application and direct the customer to your personal support URL. 

 

2.3 Terms used throughout this guide 

Customer Remote user who’s desktop you are viewing. 

Representative Local user who is viewing the customer’s desktop. 

Local PC Representative’s PC. 

Remote PC Customer’s PC. 

RemoteCall Viewer Software application that is installed on the representative’s PC. 

RemoteCall Client Temporary remote control files that are downloaded by the customer 

(remote user). 

Admin Center Administration home page used to configure the RemoteCall accounts. 

User ID Login ID assigned to a representative. 

User Name Representative’s full name. 

Display Name Name displayed to the customer when connected. 

Relay Page Page that the customer visits to connect with the representative. 

Session Agreement Page Customer authorization page required to allow remote support. 

Connection Page Page that the customer sees once the connection is established. 

Session Summary Page Page that is displayed after the session has ended, displaying the support 

session details. 

http://www.remotecall.net/
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Group Parent directory for User accounts. 

User Account associated with a specific support representative. 

Support Incidents A quick way to document the reason for the support request. 

Favorites A quick link to a commonly used URL that can be pushed to the 

customer’s PC. 

Session Remote connection between the customer and the representative. 

Web Icon Connection method involving a clickable icon. 

Session Code 6-digit code used by the customer to connect with the representative. 

Screen-Sharing Process of viewing the remote desktop via the Viewer. 

Remote Control Using either keyboard and/or mouse control on the remote desktop via 

the Viewer. 

Waiting Icon Number (No.) Representative number that is displayed to the customer on the Relay 

Page. 

P2P A direct connection between two PCs (bypassing the RemoteCall gateway 

server). 

Gateway A connection between two PCs which is relayed through a gateway 

server. 

VRVD Virtual Remote Video Driver is RSUPPORT’s proprietary video driver for 

screen-sharing. 

GDI Graphics Device Interface is a Windows proprietary video driver. 

 

2.4 How does RemoteCall Work? 

This section explains the fundamentals of how RemoteCall works. 

 

1. A connection is established between the representative and the remote user to initiate remote support. 

The representative launches RemoteCall Viewer  to start the support session. The Relay Page URL and 
Session Code will appear in the RemoteCall Viewer window automatically. The representative then directs 
the user to access the URL (i.e., http://rsup.net). 

 

2. After the necessary components are downloaded by the browser, the remote user simply clicks on the 

representative’s numbered icon  or enters in the session code to connect. 
 

3. Next, the representative initiates support by chatting with the remote user and scanning the system to 
diagnose any problems. If required, the representative may activate full keyboard and/or mouse control 

 to further assist the remote user. 
 

4. Once the problems have been resolved the session can be disconnected by either the remote user or 
representative. The remote user is then directed to a session summary webpage where they will see a log 
report of the session. Session details such as support session length, representative and contact 
information are shown. 
 

 

http://rsup.net/
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2.5 Technology and Security 

RemoteCall utilizes full 256-bit Advanced Encryption Standard (AES) and industry standard Secure Socket Layer 

(SSL) encryption for all transmitted data. All data transmitted is secure and cannot be read by others. Connecting 

through one of our gateway servers, a direct link is established between the representative and remote user and is 

maintained until one side ends the connection. 

RemoteCall also guarantees the fastest remote connection possible due to our proprietary Virtual Remote Video 

Driver (VRVD) and high speed packet switching technology; regardless of how many users are connected. 

While connected, the remote user maintains full control of their system and may disconnect the session at any 

time. The remote user may suspend representative control at any time by simply pressing ‘Ctrl+Alt+Shift’. Once the 

session has been ended, the connection is terminated and may not be re-established without the remote user’s 

authorization. 

Below is a detailed list of our other built-in security features: 

Secured Connection 

RSUPPORT guarantees each connection with full 256-bit AES and 128-bit SSL data encryption securing 

your remote session.  

Data Encryption and Storage 

All session logs, statistics and user histories are encrypted and stored on our servers. At any time you have 

instant access to this information online.  

UAC (User Authorized Control) 

Support sessions require remote users, to give authorization before any control or interaction is 

requested from the representative. Various security settings can be enabled that request permission for 

different functions.  

Tiered Control System 

Gaining the trust of your customers is the foremost priority in remote support. RemoteCall is designed to 

offer a tiered control system starting with passive secondary controls and progressing to primary mouse 

and keyboard control. This allows the representative to guide the customer through their problems by 

using various support tools, such as Interactive Draw, Co-operative Browsing, and Point without the need 

to take primary control of their mouse and keyboard.  

 

The customer will maintain full control of their keyboard and mouse during the entire session (even while 

sharing with the representative), and can terminate the session whenever they wish. Each RemoteCall 

session is a one-time connection, so the representative cannot reconnect with the customer’s machine 

once the session has been terminated.  

Zero Footprint 

Once the session ends, the customer has the option of removing all the RemoteCall components from 

their system. There is no harm in leaving the components on the system for a future support session, but 

these can always be downloaded again if necessary. 
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3.0 Installing RemoteCall Viewer 

This section explains the installation and setup process for RemoteCall Viewer. Please make sure you have the 

following system requirements before proceeding. 

3.1 System Requirements 

OS Windows 9x, 2000, XP, Vista 

HW P2 800 Mhz or higher 

Browser IE 5.0 or higher 

Disk Space 10 MB 

RAM 256 MB 

Internet Connection 56 kbps or higher (broadband recommended) 

 

 

3.2 Downloading and installing RemoteCall Viewer 
 

1. Access the RemoteCall homepage (www.remotecall.net) 

2. Select the Support menu and click [RemoteCall Viewer] from the Downloads section. 

3. Run the executable file [rc40.exe] and follow the on-screen instructions 

a) Choose your installation language and click [Next] 

b) Read and agree to the End-User License Agreement and click [Next] 

c) Choose the destination folder for the installation and click [Next] 

d) If you use a proxy server, select the appropriate option and enter your proxy server details 

and click [Next] 

e) When prompted to “Choose ID type”, select “I already have a RemoteCall ID”. 

f) Once the installation completes RemoteCall Viewer will launch and update itself 

automatically. 

 

3.3 Running RemoteCall for the first time 

When prompted, enter your user ID and password to login. Once logged in, a support session will start 

automatically. Session details such as the Relay Page URL and session code will be displayed in the 

window.  The session status will read “Waiting” until you make a connection with a customer. 

Note: You may manually start a new session by clicking the [New Session] icon from the toolbar or 

selecting New Session from the Connection menu. 

 

  

http://www.remotecall.net/
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4.0 Connecting with a Remote PC 

Once RemoteCall is installed and ready to use, you may attempt a connection with a remote PC. To connect with a 

remote pc you simply need to launch the RemoteCall Viewer application and direct the remote use to your Relay 

Page URL (e.g., http://rsup.net) and get them to enter the 6-digit “Session Code”. 

4.1 Connection Methods 

Depending on how your RemoteCall account is setup, the customer will be prompted to enter a 6-digit 

session code, or click a flashing icon. 

Note: To change the default connection method (Session Code / Web Icon) please contact your account 

manager at RSUPPORT or e-mail support@rsupport.com. 

Note: The customer needs to install an ActiveX control to initiate remote support through the website. If 

the customer is unable to install the ActiveX control they can initiate a “Manual Connection” by running 

the RemoteCall client executable. 

 

4.1.1 Session Code 
 

The Session Code connection method utilizes our main Relay Page (http://rsup.net) and is the default 
connection method when using RemoteCall. The Session Code connection method utilizes a 6-digit 
session code to connect the customer with the representative.  
 
When the customer visits the Relay Page they will be prompted to enter the session code and click 
[Connect]. 

 
 
 ActiveX Installation 

The customer needs to click the yellow bar at the top of the 

page and select [Install]. Once the ActiveX installation is 

complete the page will refresh automatically and prompt the 

customer to enter the 6-digit session code. 

 
 
 

           Fig [4-1] Session Code ActiveX 

 
 
 Manual Connection 

The user needs to click [Manually Start] to run the 

RemoteCall client executable. Once they run the client they 

can enter the 4-digit session code in the input box. 

           Fig [4-2] Session Code .exe 

 

http://rsup.net/
mailto:support@rsupport.com
http://rsup.net/


RSUPPORT RemoteCall ASP 4.0 User’s Guide Page | 13 

RSUPPORT CO, Ltd. © 2008. All rights reserved. - (www.rsupport.com) - 2F Nano Bldg., 149-11 Bangi-dong, Songpa-gu | Seoul, Korea 138-050 

info@rsupport.com | tel: +82 70-7011-3900 | fax: +82 2-479-4429 

4.1.2 Web Icon 

The Web Icon connection method utilizes your personal Relay Page URL (e.g., 

http://rsup.net/companyname) and offers a simple way for the customer to connect with a 

representative. 

When the customer visits your personal Relay Page URL they will be presented with a flashing numbered 

icon for each representative currently logged in. The customer just needs to click this icon to initiate the 

remote support session. 

 

 

 ActiveX Installation 
The customer needs to click the yellow bar at the top of the 

page and select [Install]. Once the ActiveX installation is 

complete the page will refresh automatically and display the 

representative’s flashing icon. 

 

                
              Fig [4-3] Web Icon ActiveX 

 

 Manual Connection 
The user needs to click [Manually Start] to run the RemoteCall 

client executable. Once they run the client they can click the 

representative’s flashing icon from within the application window. 

   

                 Fig [4-4] Web Icon .exe 

 

  

http://rsup.net/companyname
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4.2 Ending the Support Session 
When the session is ready to be disconnected this can be accomplished in a number of ways. 

1. Exit out of the RemoteCall Viewer entirely. 
2. Click the small black [X] at the end of the session tab bar to close the active session tab. 
3. Click [Disconnect] from the Connection menu. 
4. Click [Disconnect] from the Session Status Window. 

 
            Fig [4-5] Ending the support session 

 

4.3 Connecting Multiple Users Simultaneously 
RemoteCall allows you to support multiple remote users simultaneously. To connect with another remote 

user if you are already engaged in a session, do the following: 

  

1. While in a session, click the New Session icon on the toolbar (or click New Session from the 

Connection menu). A new tab titled Waiting 2 will appear.  

2. Opening an additional session causes a second connection icon to appear on your relay webpage. 

3. Direct the new remote user to your relay webpage, and have them click the new connection icon. 

4. To end the Session, click Disconnect from the Connection menu or close the session tab. 

 
 
 
 
 
 
 
 

  Fig [4-6] Creating a new session 

Fig [4-7] Dual Web Icons 
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5.0 Support Features and Tools 

This section explains how to navigate RemoteCall’s interface and use the tools and features. RemoteCall has an 

intuitive design that makes it easy to find what you’re looking for. 

5.1 RemoteCall Interface 

The RemoteCall interface consists of two interfaces, the representative and customer side. The RemoteCall Viewer 

is the representative interface and the Session Status Window is the customer interface. 

5.1.1 RemoteCall Viewer 
 

 
Fig [5-1] Representative Interface (RemoteCall Viewer) 

1. Main menu and toolbar 
2. Remote PC Name and IP Address 
3. Shortcuts, Remote Diagnostics, Remote Processes, and Session Log sidebars 
4. Screen Capture and Clipboard Sidebars 
5. Text Chat 
6. Draw Toolbar 
7. Session Status Bar 

  



RSUPPORT RemoteCall ASP 4.0 User’s Guide Page | 16 

RSUPPORT CO, Ltd. © 2008. All rights reserved. - (www.rsupport.com) - 2F Nano Bldg., 149-11 Bangi-dong, Songpa-gu | Seoul, Korea 138-050 

info@rsupport.com | tel: +82 70-7011-3900 | fax: +82 2-479-4429 

Main Menu and Toolbar 
 
The RemoteCall Viewer toolbar provides quick access to all of the RemoteCall commands found in the 
menus. Simply click the icon of the tool you wish to use. This section explains each tool in detail.  
 

 
Fig [5-2] Representative Main Menu and Toolbar 

 New Session launches a new session window within the Viewer. 

 Mouse/Keyboard Control takes control of the customer’s keyboard and mouse. 

 Mouse Chase displays the real-time location of the customer’s mouse cursor. 

 Laser Pointer/Arrow highlights sections of the remote user’s desktop using a laser pointer or 

arrow. 

 Draw allows the representative to draw on the remote desktop in real-time. 

 Interactive Draw allows both the remote user and representative to draw on the remote desktop 

together. 

 Screen Capture takes snapshots of the remote desktop that can be saved as an image file. 

 File Transfer sends files to/from the remote PC. 

 Clipboard Share sends and receives the clipboard contents (such as files, text and images). 

 URL Push automatically opens the web browser and designated URL on the remote desktop. 

 Zoom adjusts the scale of the RemoteCall Viewer window in sizes of 50%, 60%, 70%, 80%, 90% 

and 100%. 

 Performance Optimization let’s you improve session performance by optimizing connection and 

display settings during the session. 

 Co-Browser launches and synchronizes the remote and local browsers for cooperative browsing. 

 Presentation displays the representative’s desktop to the remote user for demonstration 

purposes. 

 Voice Chat enables VOIP allowing the representative and customer to speak to each other in 

real-time. 

 PC Sound Share streams audio from the remote PC to the local PC’s speakers. 

 Audio Settings let’s you change audio quality settings in RemoteCall to optimize performance. 

 Record starts recording the active session in full video. 

 Stop ends the recording. 

 Pause freezes the session recording. 

 

 



RSUPPORT RemoteCall ASP 4.0 User’s Guide Page | 17 

RSUPPORT CO, Ltd. © 2008. All rights reserved. - (www.rsupport.com) - 2F Nano Bldg., 149-11 Bangi-dong, Songpa-gu | Seoul, Korea 138-050 

info@rsupport.com | tel: +82 70-7011-3900 | fax: +82 2-479-4429 

The RemoteCall Viewer interface includes the following menus: 

 Connection – Session management and application settings 

 View – Screen size options, toolbar/interface settings, and the RemoteCall Log Viewer 

 Tools – Tools and session settings 

 

Connection Use the Connection menu to start a new session, disconnect an existing session or configure 
default RemoteCall Viewer settings. 

New Session Opens a new session window within RemoteCall Viewer. RemoteCall can support multiple 
sessions running simultaneously (depending on your subscription level and PC specifications). 

Disconnect Disconnects the selected session. 

Connection 
Information 

Displays relevant information about the current session, such as, connection status, connection 
method (Gateway or P2P), total session time, and remote PC name, IP, and OS version. 

Settings Configures the default settings such as connection method, data transfer method, local display 
settings and PIN code settings. 

Reboot Remote 
and Reconnect 

Reboots the remote PC and reconnects automatically; however the remote user must enter 
their windows password if required. 

Exit Exits and closes RemoteCall Viewer. 

 

View Use the View menu to configure RemoteCall’s screen size and user interface features. 

Full Screen Maximizes the RemoteCall session window to full screen. A quick menu is available at the top of 
the screen while in full screen mode. To return to a resizable viewer window, click the Full Screen 
icon or press the Esc key. 

Window-Scale to 
Fit 

Scales the image of the remote desktop to fit within the session window. 

Sidebars 
 

Displays/hides the following sidebars in the RemoteCall Viewer window: 

 Shortcuts 

 Remote Diagnostics 

 Remote Processes 

 Report 

 Screen Capture 

 Clipboard 

 Text Chat 

Toolbars Displays/hides the following sections of the toolbar at the top of RemoteCall Viewer: 

 Basic Toolbar  

 Advanced Toolbar  

 Drawing Toolbar  

 Recording Toolbar  

 Audio Toolbar  

Status Bar Displays/hides the status bar at the bottom of the session window. 

RemoteCall Player Plays back session recordings recorded by RemoteCall Viewer. 

RemoteCall Log 
Viewer 

Lists the RemoteCall Viewer session history over the past 7 days, as well as system information, 
action history, and chat history. 

Open Shared 
Folder 

Opens the shared folder on the remote PC that contains transferred files. 

Next Moves to next session window. 

Previous Moves to previous session window. 

 

Tools Use the Tools menu to select a specific RemoteCall support tool or function. 

Always on top Places the RemoteCall Viewer window on top of other windows. 

Tools Access RemoteCall support tools and functions: 
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5.1.2 Session Status Window 

During the session the “Session Status Window” is displayed on the customer’s desktop. This window 

displays the current connection and mouse/keyboard control status. The customer has access to a 

number of features and tools by simple right-clicking the window; tools such as Text Chat, Draw, System 

Information and Remote Printing. 

 
1. Session Status Window 
2. [Disconnect] button 
3. Tools menu (right-click menu) 

 

 

 

 

 

     Fig [5-3] Customer Interface (Session Status Window) 

 

Session Status Tools Menu 

Draw Enables the on-screen drawing tool for both the customer and representative. 

Chat Enables the text chat tool. 

Process Information Displays the customer PC’s running processes. 

System Information Displays the customer PC’s software and hardware details. 

File Transfer Initiates a file transfer from the customer to the representative’s PC. 

Open Received Files Opens the default shared folder on the customer’s PC used in file transfers. 

Install/Remove Remote Printer Installs the remote printer driver which enables printing from the customer’s PC 

to the representative’s local printer. 
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5.2 Adjusting Display Options 

 

5.2.1 Zoom and Scale-To-Fit 

During a session you may want to adjust the size/scale of the Viewer Window to fit the entire image of the 

remote desktop. You can accomplish this in two ways. 

 

First, you may try adjusting the zoom percentage. By default the image is zoomed at 100%, however the 

remote desktop may have a larger screen resolution than the local PC you are using. By clicking the [Zoom] 

icon  you can adjust the scale of the displayed image until it fits within your window. 

 

The other method is to click [Window-Scale-to-fit] from the View menu. This option will automatically 

scale the current image to fit within the Viewer Window. 

 

5.2.2 Full-Screen Mode 

During a session you can view the remote desktop in full-screen mode (View > Full-Screen Mode). While 

in full-screen mode, a quick access toolbar for common tools and features is located at the top of the 

screen. You can exit Full-Screen Mode at any time by clicking the [Exit Full-Screen] icon . 

 

     1         2       3         4            5        6       7        8        9 

 

 

1. Exit Full-Screen 

2. Mouse/Keyboard Control 

3. Mouse Chase 

4. Laser Pointer 

5. Draw 

6. File Transfer 

7. URL Push 

8. Application Sharing 

9. Performance Optimization 

 

  

Fig [5-4] Viewer Full-Screen Mode 
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5.2.3 Display Color Depth 
You may customize the color depth in RemoteCall Viewer to 

enhance image quality or improve performance. Open 

Performance Optimization  and select the General tab, 

then adjust the color depth of the Local Display.  

         Fig [5-5] Viewer Display Color Settings 

 

5.2.4 Screen Scrolling 
While viewing the remote desktop at 100% scale you may not be able to see the entire screen at once. 

Using the screen scrolling feature you can navigate around the screen within the viewer without the need 

to zoom out and lose detail. RemoteCall has two screen scrolling functions: 

 Auto Scroll 
Moving your cursor to the edge of the RemoteCall Viewer window will automatically scroll in the 

direction of your cursor. 

 Panning Scroll 
Clicking and holding the middle mouse button let’s you drag the screen in the direction you wish. 

 

5.3 Mouse/Keyboard Control 
 
While in a support session you may initiate mouse/keyboard control to take control of the remote PC’s 

mouse and keyboard. Press the [Mouse/Keyboard Control]  button from the toolbar. 
 
To release control of the mouse and keyboard, simply press the button again. 
 
Note: The customer may cut off control at any time by pressing “Ctrl + Alt + Shift” on their keyboard. The 
representative may not regain control of the keyboard and mouse until the customer authorizes it. 
 

The representative may view the remote cursor by pressing the [Mouse Chase]  button from the 
toolbar. 
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5.4 Drawing 
 
While in a session the representative can initiate the draw function by clicking either draw icon from the 

toolbar [Draw] or [Co-operative Draw]. 
 

 Clicking [ ] initiates regular Draw mode where the representative can draw on the customer’s 
desktop. To erase the drawn images, simply click the draw icon again. 

 Clicking [ ] initiates Co-operative Draw which allows both the representative and customer to 
draw on-screen simultaneously.  To erase the drawn images, simply click the draw icon again. 

 
Co-operative Draw also enables the draw toolbar, which allows the representative to draw special images 
or write text on-screen. 
 

 
Co-operative Draw Toolbar 
 

 
     1     2     3          4     5       6        7         8           9        10     11 
 
1. Freehand 
2. Straight Line 
3. Arrow (one-sided/two-sided) 
4. Square 
5. Oval 
6. Text Stamp (enter text and choose font, color, size and style) 
7. Draw Color 
8. Draw Width 
9. Eraser (erase selected objects/erase all) 
10. Move Objects 
11. Toggle Drawing Mode (on/off) 

 

5.5 Screen Captures 
 
You can take screenshots of the remote desktop and save them to 
your local PC. 

To take a screen shot, click the [Screen Capture] icon . The image 
will be displayed in the “Screen Capture” clipboard. You have the 
option to [Save] the file or [Remove] it from the list.  
 
All saved images are time stamped and stored to the default “Capture” 
folder located in “C:\Documents and Settings\username\My 
Documents\RSUPPORT\RemoteCall Viewer\Capture\”. 
 

       Fig [5-7] Screen Capture Sidebar 

Fig [5-6] Interactive Draw Toolbar 
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5.6 File Transfers 
 
During a support session the representative may send/receive files to and from the remote PC using the 

file transfer tool . 
 
 

          Step 1     Step 2             Step 3 
 
 
 
 
 
 
 
 
 
 
 
To send a file to the remote PC: 

1. Click the “File Transfer” icon [Send File(s)]  
2. Select the file(s) you wish to send 
3. Click [Open] 
 
All file transfers to the remote PC will be sent to the default shared folder “RCTemp” located in 

“C:\Documents and Settings\username\My Documents\RCTemp\”. Once the file transfer has 

completed, the shared folder will open automatically on the remote PC. 

  

To receive a file from the remote PC: 

1. Click the “File Transfer” icon [Get File(s)]  
2. Select the file(s) you wish to receive 
3. Click [Open] 

 
All file transfers from the remote PC will be sent to the default “Shared Folder” located in 

“C:\Documents and Settings\username\My Documents\RSUPPORT\RemoteCall 

Viewer\SharedFolder\”. Once the file transfer has completed, the shared folder will open 

automatically on the local PC. 

 

Note: RemoteCall also supports Drag & Drop file transfers. 

 The representative may drag and drop a file into the RemoteCall Viewer to initiate a file transfer to 
the remote PC. 

 The customer may drag and drop a file into the Session Status Window to initiate a file transfer to 
the local PC. 

Fig [5-8] File Transfer Step by Step 
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5.7 Clipboard Sharing 
 

Standard Clipboard Sharing 
During a session the local and remote clipboard contents may be transferred 
between PCs. RemoteCall utilizes an automatic clipboard function using 
windows hotkeys [Ctrl + C] “Copy” and [Ctrl + V] “Paste”. Clipboard contents 
may be transferred by simply “Copying” content on one PC and “Pasting” it on 
the other. 
 
Example: You could copy a URL from your web browser and paste it into the 

address bar on the remote PC’s web browser, without the need to type it in 

again. 

Enhanced Clipboard Sharing 
RemoteCall also utilizes an “Enhanced Clipboard Sharing” function which 
allows the representative to see the clipboard contents of the remote PC in 
real time and [Save] them to a text file. Using the “Clipboard Sidebar”, the 
representative can view and [Save] clipboard contents as they wish. Clicking 
[Remove] will remove the clipboard entry from the list. 
 
 
 
Note: Removing a clipboard entry from the list does not remove it from the actual remote PC clipboard. 

 

 

5.8 URL Push and Co-operative Browsing 
 

URL Push 

You can easily send a URL to the remote PC by clicking the [URL Push] icon . Simply type in the URL 
you wish to send and click [Send]. 
 

 
Co-operative Browsing 
 
Co-operative browsing is used to browse web pages with the customer in real-time without the need to 

physically control their PC. Clicking the [Co-operative Browsing] icon  launches a web-browser on 
each PC simultaneously, synchronizing the two. As the representative types in URLs and navigates sites, 
the remote PC browser follows along in real-time. 

 

  

Fig [5-9] Clipboard Sidebar 
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5.9 Presentation Mode 
 
Presentation mode is a reverse screen-sharing function which allows the representative to display their 

desktop to the customer. Simply click the [Presentation Mode] icon  and click [Yes] to confirm. The 
screen will refresh (this may take a few moments) and enable the VRVD driver on the local PC. 
 

 
 
 
Using the “Presentation Manager” (shown above) the representative may Pause or Close the screen-
sharing session at any time by pressing the respective button. Clicking the [Draw] checkbox will enable 
draw mode allowing the representative to draw on their desktop. 
 
Note: During presentation mode, the customer has NO control of the representative’s desktop. 
Presentation mode is used strictly for screen-sharing only. 

 

 

5.10 Voice Chat and Remote PC Audio 

During a session the representative may initiate VoIP Voice Chat for real-time communication with the 

customer, as well the representative can listen to audio coming from the remote PC using the PC Sound 

Share feature. 

Note: Voice chatting requires that both users (local and remote) have a working headset and 

microphone. 

 

 Warning: Your volume level will increase to 90% when [Voice Chatting] or [PC Sound Share] is 
enabled. 

 

 Clicking the [Voice Chat] icon initiates VoIP voice chatting between the two PCs allowing voice 
communication between the two users. 

 Clicking the [PC Sound Share] icon  initiates remote PC sound sharing allowing the representative 
to listen to audio coming from the remote PC. 

You may adjust the audio quality settings after initiating Voice Chatting or PC Sound Share by clicking the 

[Audio Settings] icon  to adjust quality and performance. 

 

Audio settings include: 
Frequency: Adjust the band of audio being used (narrowband, wideband, ultra-wideband) 

Bit-rate: Adjust the data bit-rate being used (2kb/s ~ 30kb/s) 

Host/Remote Volume: Adjust the volume level of both the microphone and speakers. 

Remote PC Sound: Adjust the volume level of the remote PC. 

Fig [5-10] Presentation Manager 
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5.11 Session Recording and Playback 

A representative can record an entire session to disk and play it back at any time using RemoteCall Player. 

RemoteCall Player uses its own compression and file format which reduces file size and enhances security. 

The session recording can only be played back using RemoteCall Player. 

 Press [Record]  from the toobar or from the Tools menu to initiate session recording. 

 Press [Pause]  from the toobar or from the Tools menu to pause the session recording. 

 Press [Stop]  from the toobar to stop the session recording. 

 

Note: Once the session recording is stopped it will be automatically saved to the Recording folder 

located in “C:\Documents and Settings\username\My Documents\RSUPPORT\RemoteCall 

Viewer\Recording\”. Each recording is named automatically and time stamped with the extension “.rsf”. 

 

Playing back a recorded session: 

Recordings can be played back using the RemoteCall Player application. RemoteCall Player can be 

launched from within the RemoteCall Viewer using the View menu or externally by running the 

application from the Start Menu. RemoteCall Player is located in the same folder as RemoteCall 

“RSUPPORT\RemoteCall Viewer 4.0\RemoteCall Player”. 

 

1. Play controls (Pause, Play, Fast-forward, Stop) 

2. Zoom controls (Zoom-in and Zoom-out) 

3. Screen Capture and Properties 

4. Video navigation bar 

5. Video details (Properties) 

 

Note: You can fast forward up to 6x normal speed. 

While fast forwarding a video pressing [Play] will 

resume normal 1x speed. 

 

 

 

  

Fig [5-11] RemoteCall Player Details 
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5.12 Remote Printing 

You can print from the remote computer directly to your local printer. While in session with a remote 

computer, simply install a remote printer driver which will forward all print jobs to your local computer. 

To do this: 

1. Right-click the Session Status Window and select [Install Remote Printer] 

2. Please wait while the printer driver installs (this may take a few moments) 

3. “RSupport Remote Printer” should be listed in the “Printers Folder” 

4. When printing from the remote PC select [RSupport Remote Printer] 

5. The print request will appear on the local desktop where a local printer can be selected 

 

 

 
 

 

 

 

 

  

Fig [5-11] Remote Printing Installation 
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5.13 Viewer Shortcuts 

The Shortcuts sidebar includes quick access to commonly used Favorites (URLs), System Folders, 

Programs, and Control Panel tools. To open the “Shortcuts” sidebar simply click [Shortcuts] on the side of 

the Viewer. 

 

5.13.1 Favorites 

From here the representative can manage a list of URLs that can be sent 

to the remote PC with a single click. URLs can be stored individually or 

within folders for organization. 

Adding a URL/Folder:  

1. Click [Add] from the Favorites sidebar 
2. Type in the display name and URL (or click [Create Folder] to 

create a new folder) 
3. Click [Add] again 

 

 

Note: You can drag and drop Favorites into folders to keep them organized.  

 
Editing a URL/Folder 

1. Click [Edit] from the Favorites sidebar 
2. Select the URL/Folder you wish to edit 
3. Edit the information you wish to change 
4. Click [Edit] to save your changes 

 
Note: You can drag and drop Favorites into folders to keep them organized. 

 
Removing a URL/Folder 

1. Click [Delete] 
2. Select the URL/Folder you wish to delete 
3. Click [Delete] again 

 

Fig [5-12] Viewer Shortcuts > Favorites 

Fig [5-13] Viewer Shortcuts > Favorites > Add/Remove 
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5.13.2 Folders 

From here the representative can quickly launch common system folders on the remote PC with a single 

click, such as “Windows”, “System”, “Program Files” and more. 

 

5.13.3 Control Panel 

From here the representative can quickly launch Control Panel tools with a single click, such as 

“Add/Remove Programs”, “Windows Firewall”, “Internet Options” and more. 

 

5.13.4 Programs 

From here the representative can quickly launch commonly used system applications and services such as, 

“Control Panel”, “Event Viewer”, “DirectX Diagnostics” and more. 

 

 

Fig [5-14] Viewer Shortcuts > Folders 

Fig [5-15] Viewer Shortcuts > Control Panel 

Fig [5-16] Viewer Shortcuts > Programs 
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5.14 Remote Diagnostics 
 
The representative can take a snapshot of the remote PC’s system diagnostic 
information directly through the RemoteCall Viewer. After the session has 
started, RemoteCall can scan the remote PC to collect the system information 
such as CPU type, Memory, BIOS, Network Adapter and more. 
 
This information is only gathered once and can be refreshed by clicking the 
[Refresh] button if necessary. 
 

 

 

 

 

 

 

5.15 Remote Processes 

In addition to viewing the remote PC’s system diagnostics, the representative 

may also view the running processes on the remote PC. 

 Refreshing the List 
The process list is only updated once when the session begins. To refresh 

the list click the [Refresh] button. 

 Killing a Process 
To End a process, select the process you wish to terminate and click the 

[End Process] button (or right-click the process and select [End Process]. 

 Copy Process List to Clipboard 
The process list may be copied to the local clipboard to be saved or 

analyzed. Right-click anywhere in the process list and select [Copy List to 

Clipboard]. Then you can Paste the information into a text document or 

application of your choice. 

 

  

Fig [5-17] Remote Diagnostics List 

Fig [5-18] Remote Processes List 
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5.16 Session Log and Log Viewer 

Session Log 

Each support session may be logged with customer contact 

information and the reason for the support session (Support Incident). 

Information logged consists of customer’s name, phone number, and 

e-mail address. Additional fields allow you to select the Support 

Incident (refer to the Admin Center section of this manual for more 

information) and enter additional Session Details. 

 

 

 

 

 

 

 

Log Viewer 

The Log Viewer is an application which allows the representative to 

view past support session history. The Log Viewer captures and 

displays all information from each support session. The Log Viewer 

can be launched from within RemoteCall Viewer by clicking the View 

menu and [RemoteCall Log Viewer] (the Log Viewer can also be 

launched from the Start Menu under “RSUPPORT > RemoteCall 

Viewer 4.0 > RemoteCall Log Viewer”). 

 

 

1. Calendar – choose the Month and Day you wish to look at. The sessions from that day will 
automatically display in the window to the right. 
 

2. Log History Length – set how many days to keep session history in the Log Viewer. 
 

3. Local Desktop Shortcuts – shows what shortcuts were present on the representative’s desktop during 
the support session. 

 
4. Session Log – displays all sessions from the day being searched. Simply double-click a session to see 

more details. 
 
5. Session Details – Displays details from the support session such as session ID, IP address, PC name, 

system information, chat log, file transfer log, and control actions. 
 

 

Fig [5-19] Session Log Sidebar 

Fig [5-20] Log Viewer Application 
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5.17 Reboot and Reconnect 

The representative may reboot and reconnect with the remote PC by selecting [Reboot and Reconnect] from the 

Connection menu. 

 

 

The remote session will be re-established once the computer is booted back into Windows. If a log in is required, 

the remote user must type in their login credentials and log in to Windows before the connection can be re-

established. 

IMPORTANT: The session WILL NOT resume until the user has logged back into Windows. 

Note: When the remote PC logs back into Windows the web browser will open automatically and reconnect with 

http://rsup.net to establish the connection. 

 

5.18 Connection Information 

During the session the representative may view connection information such as Connection Status, Video Mode, 

and IP address. This information can be accessed by clicking [Connection Information] from the Connection Menu 

or by accessing the RemoteCall Home tab and clicking [Details]. 

Connection Details Include: 
Status: The status of the connection (Connected, Disconnected, 

Rebooting etc.) 

Video Mode: The video mode used for screen-sharing (Driver or GDI) 

Connection Method: Gateway or P2P 

Connection Time: The length of the active session 

Recording: Active or Not Active 

Computer Name: The remote PC name 

IP Address: The remote PC IP address 

OS Version: The remote PC operating system and version 

Control Permissions: Controls allowed on the remote PC 

(Mouse/Keyboard/Draw) 

 

Fig [5-21] Reboot and Reconnect Menu Fig [5-22] Reboot and Reconnect Screen 

Fig [5-23] Connection Information 

http://rsup.net/
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6.0 Settings and Session Management 

This section discusses the use of RemoteCall’s settings, where you can configure visual, performance, and security 

aspects of the RemoteCall Viewer. RemoteCall has two different settings windows, General Settings and Session 

Settings. 

6.1 General Settings 

The General Settings are the default settings that are applied every time you start RemoteCall. General 

Settings is available from the login window [Settings] and from the Connection menu [General Settings]. 

The General Settings window is broken up into three tabs (Server, Network, and Session). 

6.1.1 Server 

Authentication Server 

The Authentication Server validates the representative’s login ID and 

password when signing in.  

Note: The default settings shown below normally do not require change. 

Server Address: rsup.net 

Port: 80 

Authentication Page: viewer_check asp 

 

Enabling [Use SSL Encryption] will secure all data transmitted with up to 

256-bit SSL encryption. 

 

Proxy Server 

If you use a proxy server in your network, you can configure it here. You can manually enter the Proxy IP 

address, Port, Login ID, and Password. If you are not sure of the proxy address and port you can click 

[Auto detect] to have RemoteCall try and find it for you. 

 Note: Remote PCs behind proxy servers do not require enabling the proxy settings. 

 

  

Fig [6-1] General Settings > Server 
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6.1.2 Network 

NAT (Network Address Translation) Support 

If the local PC is behind a router/firewall, the session will be connected via a 

gateway server. To improve performance, you can manually configure the NAT 

settings to force a P2P connection while connecting through a firewall. Check 

[Enable NAT Support] and enter the external IP and port of the local PC. 

Note: The router will need to be configured to forward packets to your local 

PC on a specific port. 

External IP Address: The public IP address of your network 

External Port: The port being forwarded to the local PC 

 PIN Code 

To prevent unauthorized access, check [Enable PIN-code]. The PIN-code must be 4 numeric characters in 

length, and can be generated automatically or manually. 

Note: When PIN Code connections are enabled, the User account must also be configured to use PIN 

Code connections through the Admin Page (refer to the Admin Center section of this Guide for more 

information). 

 

6.1.3 Session 

Relay Web Page 

Select Small, Medium or Large text size for the URL and Session Code display in 

the Viewer. 

 

Network Type 

Choose the speed of the remote user’s internet connection (LAN10/100MB, 

ISDN/DSL/Cable, or Modem/Satellite) for optimum performance. 

Video Mode  

Configure how image data is transmitted from the remote PC. 

 In Automatic Mode RemoteCall will automatically select the transfer 

mode best suited for the remote PC’s configuration (recommended). 

 GDI Mode transmits the entire screen image at one time. This should only be used in situations 

when you are unable to use VRVD. 

 Driver Mode utilizes VRVD for optimized performance. Running at the kernel level, VRVD uses 

less CPU and memory than GDI mode. 

 

Note: VRVD cannot install on a system with limited user rights. In this scenario RemoteCall would 

default to GDI mode. 

Fig [6-2] General Settings > Network 

Fig [6-3] General Settings > Session 
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Color Depth  

Change the color resolution displayed in the RemoteCall Viewer. You can choose from True Color, 256 

colors, 16 colors, 4 colors, or 2 colors. 

TIP: Lowering the color depth will enhance screen-sharing performance. 

Session Management 

Prevent accidental disconnections or timeouts in unstable network environments such as dial-up or 

satellite. 

 

Start Recording on Session Start 

Automatically start a session recording every time a new session is started. 

 

 

6.2 Session Settings 

The Session Settings can be modified on the fly during a support session. Session 

settings are useful for enhancing performance or quality during a support session. The 

General Settings window is broken up into three tabs (General, Advanced, and Audio). 

6.2.1 General 

Shared Folder 
Change the location of the default Shared Folder to be used for file transfers.  
 
Default Location: 
“C:\Documents and Settings\username\My 
Documents\RSUPPORT\RemoteCall\SharedFolder” 
 

Remote Display 
Change the remote PC’s resolution and color depth. 
 

Local Display 
Refer to section 6.1.3 for more details. 
 
 
 

6.2.2 Advanced 

Network Type 
Refer to section 6.1.3 for more details. 

 Video Mode 

Refer to section 6.1.3 for more details. 

  

Fig [6-4] Session Settings > General 

Fig [6-5] General Settings > Advanced 
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Screen Scroll 
Select the screen scrolling functions for the RemoteCall Viewer window. 

 Auto Scroll will pan the screen automatically when the cursor reaches the edge of the screen. 

 Panning Scroll is a click and drag method of scrolling. Simply hold down the middle mouse 
button to click and drag the screen. 

 

Game Support 
Enabling either of these features will allow remote access in online gaming or other environments that 
restrict remote access control. 
 
 

6.2.3 Audio 

Quality 
Adjust audio quality settings for VOIP and Remote PC Sound, such as bit-rate 
(kbps) and frequency range (kHz). Reducing the bit-rate and/or frequency range 
will increase performance but lower audio quality. 

Volume 
Adjust the microphone and speaker level of both the remote and local PCs. 

Share Remote PC Sound 
Enable or disables the sharing of the remote PC audio and adjust the volume 
level. 

 

 

  

Fig [6-6] General Settings > Audio 
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6.3 Examples of Session Settings 

Best Performance 
When using a high-speed network (Broadband or LAN), it is possible to watch streaming media and 

graphics on the remote PC.  

 

For the best performance possible, we recommend adjusting the following settings: 

 

For the best response time 

 Connection: LAN 

 Video Mode: Driver  

 Color Depth: 256 Colors 

 

For the best display quality 

 Connection: LAN 

 Video Mode: Driver 

 Color Depth: True Color

 

For Low-Speed Internet 
RemoteCall can support customers with low-speed Internet access—even those using a 56K dial-up 

modem or a 2-way satellite for Internet access. Before connecting you may adjust the default settings 

using the General Settings menu. Also, you can click the [Session Settings] button on the Toolbar  to 

adjust the settings after the session has started.  

For low speed networks we recommend adjusting the following settings: 

 Connection: Dial-up/Satellite 

 Video Mode: Driver 

 Color Depth: 16 Colors 

 

 

For Graphic and Multimedia Files 
If you need to support users with graphic or multimedia intensive applications such as CAD or online 

learning, we recommend adjusting the following settings for the best display quality and response time. 

 Connection: LAN 

 Video Mode: Driver  

 Color Depth: True Color 
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7.0 Admin Center 

RemoteCall ASP offers customers a powerful admin center to manage user accounts, edit permission settings, 

check session statistics, and more. This section will explain in detail all of the features and functions of the 

RemoteCall Admin Center. 

The Admin Center is broken down into 5 main sections: 

1. Session Log 
2. Users 
3. Reason for Call 
4. Statistics 
5. Account Profile 

 

Logging In 

To access the Admin Center you need to login to the RemoteCall homepage (www.remotecall.net) with your User 

ID and password. The Admin Center console will open automatically upon logging in. Once logged in, you may 

access the Admin Center manually by clicking the [Admin] button. Clicking the [Web Viewer] button will allow you 

to access the Web Viewer application (this will be explained in more detail in the Web Viewer section of this 

manual). 

 

 
 

  

http://www.remotecall.net/
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7.1 Session Log 

Session History displays a log of all support sessions that have taken place in the past. You may search by 
User ID, Name, or Screen-Name and select a range of dates to narrow your search results. All Session 
History reports may be exported to an Excel file by clicking [Excel Download]. 

 

 

Clicking a session number will display more detailed information about the session such as IP address, PC 
Name, and Login Time, as well as customer information such as Name, Phone number, and E-mail address.  
The Session Report may be updated from here by clicking [Report Update]. 
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7.2 Users 

The Users menu displays all users associated with your account and their respective subscription terms. 

Clicking a User ID will display more detailed information about the user and allow you to modify the user’s 

details and permission settings.  

 

 

7.2.1 User Details 

After clicking a User ID you will be see the user’s details and permission settings.  

To change the user’s details: 

1. Click [Change]  
2. Make the updates  
3. Click [Update] 

 

To assign a new password: 

1. Click [Change] 
2. Enter the new password twice in the password fields 
3. Click [Update] 
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7.2.2 Permission Settings 

The permission settings control the user’s access to RemoteCall’s tools and features. As well, you can 

enforce specific security settings such as mandatory screen-sharing authorization and mouse/keyboard 

authorization.  

The permission settings are broken up into three categories (Primary Controls, Secondary Controls, and 

Security Settings). 

To update the permission settings: 

1. Click [Edit] 
2. Make your changes 
3. Click [Update] 
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Permission Settings Breakdown: 

Primary Controls 

File Transfers Transfer files to and from the customer’s PC 

Reboot & Reconnect Reboot and automatically reconnect with the customer’s PC 

Remote Processes View and control remote processes running on the customer’s PC 

Session Recording Record the entire session to disk for review and auditing purposes 

Mouse Control Allows the representative to take control of the customer’s mouse 

Keyboard Control Allows the representative to take control of the customer’s keyboard 

System Diagnostics View system diagnostic information from the customer’s PC 

Session Reporting Fill out a session report documenting the customer’s information and reason 
for support 

 

Secondary Controls 

Presentation Mode Show your desktop to the customer in a reversed screen-sharing mode 

Screen Captures Take a screen capture of the customer’s desktop and save them to disk 

URL Push Send a URL to the customer’s PC automatically opening their browser 

Co-Browser Launch the default browser on both PCs (representative and customer) and 
synchronize the browsing 

System Shortcuts Access quick shortcuts to commonly used URLs, folders, and control panel 
tools. 

Session Summary Displays a summary of the support session to the customer after 
disconnection 

Draw (One-Way) Draw on the customer’s desktop 

Draw (Two-Way) Allows both the representative and customer to draw on the customer’s 
desktop 

Text Chat Chat with the customer using a instant messenger window 

Voice Chat Talk with the customer using VoIP 

Clipboard (Auto) Automatically send clipboard contents to and from the customer’s PC when 
using Windows Hotkeys (Ctrl + C / Ctrl + V) 

Clipboard (Enhanced) View the customer’s clipboard contents before transferring 

 

Security Settings 

File Transfer Agreement Requires customer authorization before transferring files or rebooting 
the customer’s PC 

PIN Code Enforces PIN Code connections requiring the customer to enter a PIN 
Code when connecting using the Web Icon method. 

Screen-sharing Agreement Requires customer authorization before beginning screen-sharing 

Controls Agreement Requires customer authorization before granting the representative 
mouse/keyboard control 
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7.3 Reason for Call 

Each support session can be logged with the reason for the support request (e.g., Internet Browser 

Problem, Windows blue screen error, etc.). You may create a custom list of “reasons” in this section. 

To create a new “Reason for Call”: 

1. Click [Add] 
2. Type in the category, description, and priority level of the “reason” 
3. Click [Add] again 

 

Note: The “Priority level” determines where in the list the “reason” will show up. A priority 1 will 

show up higher in the list than a priority 2 for example. 

To delete a “Reason for Call”: 

1. Click the checkbox of the “Reason” you wish to delete 
2. Click [Delete] 

To edit an existing “Reason for Call”: 

1. Click the checkbox of the “Reason” you wish to edit 
2. Edit the details as necessary 
3. Click [Update] 

 

 

  



RSUPPORT RemoteCall ASP 4.0 User’s Guide Page | 43 

RSUPPORT CO, Ltd. © 2008. All rights reserved. - (www.rsupport.com) - 2F Nano Bldg., 149-11 Bangi-dong, Songpa-gu | Seoul, Korea 138-050 

info@rsupport.com | tel: +82 70-7011-3900 | fax: +82 2-479-4429 

7.4 Session Statistics 

Session statistics displays reports of past session activity such as call volume, user call time, support 

incidents, session length and more. All reports are displayed on-screen and may be exported to an Excel 

file by clicking [Excel Download]. 

The statistics section is broken down into 7 sub-menus: 

 Year 

 Month 

 Day 

 User Call Time 

 Session Length 

 OS Used 

 Reason for Call 

 

 

7.4.1 Year 

The Year tab displays call volume per month over the course of a year. You may select the year you wish 

to display (e.g., 2008). Placing your mouse over one of the bars displays details for that month. 
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7.4.2 Month 

The Month tab displays call volume per day over the course of a single month. You may select the month 

you wish to display (e.g., January). Placing your mouse over one of the bars displays details for that day. 

 

 

7.4.3 Day 

The Day tab displays call volume per hour between two specific dates. You may select the dates you wish 

to display (e.g., 2008-01-01 ~ 2008-04-30). Placing your mouse over one of the bars displays details for 

that time. 
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7.4.4 User Call Time 

The User Call Time tab displays call volume per user between two specific dates. You may select the dates 

you wish to display (e.g., 2008-01-01 ~ 2008-04-30). Placing your mouse over one of the bars displays 

details for that user. 

 

7.4.5 Session Length 

The Session Length tab displays call volume per session length between two specific dates. You may select 

the dates you wish to display (e.g., 2008-01-01 ~ 2008-04-30). Placing your mouse over one of the bars 

displays details for that session length. 

 



RSUPPORT RemoteCall ASP 4.0 User’s Guide Page | 46 

RSUPPORT CO, Ltd. © 2008. All rights reserved. - (www.rsupport.com) - 2F Nano Bldg., 149-11 Bangi-dong, Songpa-gu | Seoul, Korea 138-050 

info@rsupport.com | tel: +82 70-7011-3900 | fax: +82 2-479-4429 

7.4.6 OS Used 

The OS Used tab displays call volume per operating system between two specific dates. You may select 

the dates you wish to display (e.g., 2008-01-01 ~ 2008-04-30). Placing your mouse over one of the chart 

sections displays details for that operating system. 

 

 

7.4.7 Reason for Call 

The Reason for Call tab displays call volume per “reason for call” between two specific dates. You may 

select the dates you wish to display (e.g., 2008-01-01 ~ 2008-04-30). Placing your mouse over one of the 

chart sections displays details for that “reason for call”. (Refer to the “Reason for Call” section of the 

Admin Center for more details) 
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7.5 Account Profile 

The Account Profile section lists personal account information for the primary account holder 

(Administrator) and license details for all secondary users on the account.  

You may update the primary account holder’s information such as Password, Company name, Address, 

Country, E-mail, and Phone #. To update the information click [Update], edit the information, and click 

[Update] again to confirm. 
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8.0 RemoteCall FAQs 

General 

1. Do I need to pre-install software on the remote user's PC?  
No, there is no need for pre-installed software. The remote user simply visits the designated support 
URL where the RemoteCall controls are downloaded by their browser. The remote session runs only 
once and cannot be re-established unless authorized by the remote user. 
 

2. Are there any files left behind on the customer’s PC? 
When the remote session is disconnected, the remote user is prompted with the option to remove 
the remote control files from their PC. Keeping the remote control files on the PC does not pose any 
threat as all connections must be authorized by the remote user before a remote session is 
established. Keeping the remote control files allows for a quicker connection to a support 
representative in the future.  
 

3. Can RemoteCall Connect to an unattended computer? 
No, RemoteCall is specifically designed as a remote support tool requiring two users to complete the 
connection. The customer must authorize the connection before the representative can connect. 
 
Note: For unattended remote access please refer to RemoteView. 
 

4. Can a support Agent reconnect at any time? 
No, RemoteCall is designed for one-time connections only. Once the session has been disconnected, 
the representative cannot reconnect unless the customer initiates another session. 
 

5. How long does each connection last? 
Each RemoteCall session can last as long as you need. There are no time limits built into the service. 
 

6. Can RemoteCall connect over a VPN (Virtual Private Network)? 
Yes, RemoteCall can connect in virtually any network environment including VPNs, Proxy Servers, 
Firewalls etc. 
 

7. Can I connect to a remote PC behind a firewall or proxy?  
Yes, RemoteCall works transparently through any firewall or proxy without the need to change your 
existing network settings. 
 

8. Can I transfer files to and from the remote PC?  
Yes, RemoteCall supports both standard and drag & drop file transfers to and from the remote PC. 

 
9. How does the remote user know when they are connected? 

a. A dialogue box appears on the screen notifying the remote user that a connection has been 
established.  

b. "Supporting..." is displayed in the bottom right corner of the screen during the remote session. 
 

10. Can I run more than one remote session simultaneously? 

RemoteCall ASP allows up to two support sessions to run simultaneously by default. However, more 

simultaneous sessions may be added if necessary. To launch a second session click the “New Session” 

button from the RemoteCall Viewer toolbar and a new session tab will appear. 
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11. Can the Remote sessions be recorded?  
Yes, each session can be recorded at any time and saved to the local PC; the recordings can then be 
viewed using RemoteCall Player. 

 
12. Can the remote user still connect if they don't install the ActiveX controls? 

Yes, the customer has the option of running a manual .exe file from the connection page if they 
cannot or do not wish to install the ActiveX control. 

 
13. Can I show my desktop to the customer? 

Yes, RemoteCall has a presentation tool which allows you to display your desktop to the remote user. 

14. Can the remote user control the representative's desktop in presentation mode? 
No, the remote user has no control capability. The presentation mode is used solely for displaying the 
representative's desktop to the customer. 

 
15. Can the customer block any programs they don't want the representative to see? 

Yes, if you enable “Application Sharing” the user has the choice of what programs to allow access to 
when the support session begins. By default all applications and windows would be blocked from 
view until the customer chooses to share them. 

16. When connecting with a limited user account can I login as an Admin? 
RemoteCall does not allow you to logout and login as another user during the session, however it 
does offer system shortcuts which allow you to change and update system and configuration settings 
from within the Viewer. As well you may use the “Run As” command to elevate your privileges while 
in session with a limited user. 

 

Support 

17. Why didn't the remote PC reconnect after a system reboot?  
a. If the remote PC requires a login password, the user must input the password before a 

connection can be re-established.  
b. If the remote PC requires a manual connection to the internet, the remote user must re-establish 

the internet connection and refresh the Connection Page. 
 

18. Why can't anyone enter a password on the remote PC? 
RemoteCall can block the representative’s ability to enter passwords on the remote PC for security 
reasons. 

 
19. Where are the transferred files, screen captures, and session recordings saved? 

All session related files on the local PC are stored in their respective folders under “C:\Documents and 
Settings\USERNAME\My Documents\RSUPPORT\RemoteCall\”.   
Note: The default locations can be changed if needed. 

 
20. Why can’t I switch to VRVD (Virtual Remote Video Driver) Mode?  

If you are unable to change the Video Mode to VRVD you may need to manually remove the VRVD 
from the remote PC's Device Manager. Once removed you must reboot and reconnect with the 
remote PC. The Video Mode should then revert back to VRVD automatically. 
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21. How do I print documents from the remote PC to my local printer? 
You must make sure to install the Remote Printer Driver. To do so, right-click the Session Status 
window on the remote user's desktop and select “Install Remote Printer”. Once the installation is 
complete you may select “RSupport Remote Printer” from the list of printers when printing a 
document on the remote PC. 

 
22. Why does my browser just sit on the Connection Page? 

a. You may not have sufficient privileges to install ActiveX components. 
b. You are running Firefox or Opera and cannot run ActiveX components. 
Note: Refer to FAQ #12 for details on connecting without ActiveX. 

 
23. Why does the session connect as a gateway and not a P2P when I’m connecting to a LAN PC?  

If you are running RemoteCall for the first time or have not added it to the Windows Firewall 
Exception List then it will default to the gateway. When prompted by Windows Firewall click "Allow" 
to add RemoteCall as an exception and try connecting again. 

 
24. How do I enable PIN Code connections? 

PIN Code connections can only be activated on accounts using the “Web Icon” connection method. 

This function needs to be enabled from the online admin center before it can be activated within the 

RemoteCall Viewer. Please refer to the Admin Center section of the RemoteCall Users Guide for 

more information. 

25. Why does the screen stay black after connecting with the remote PC? 

The remote PC may not have sufficient privileges to install and run the remote video driver (VRVD). In 
this case you must switch the RemoteCall Viewer video mode to GDI mode. GDI mode offers slightly 
less performance than VRVD but will run in virtually any system configuration. 
 

26. Why does the remote desktop look all strange and out of perspective? 

If the remote PC is a virtual machine (VM OS) and the screen is set to an odd resolution size then 
RemoteCall Viewer may have trouble displaying this. This can be corrected by either switching to True 
Color mode in the RemoteCall Viewer settings or changing the remote OS resolution to a standard 
size (such as 1024 x 768, 1280 x 1024, 1280 x 768 etc.). 
 

27. When I run RemoteCall Viewer and try to login it says “Failed to download update.zip” why? 

a. Check that the Server Address in the RemoteCall Viewer settings is correctly set to “rsup.net”. 

b. Make sure your firewall is allowing RSAutoUp.exe to access the internet. 

Note: RSAutoUp.exe is used to check and update RemoteCall to the latest version and must be 
able to run and connect to the update server each time RemoteCall starts. 

 

28. Why does the customer’s browser hang on the “Connected” screen after entering the session-code? 

If the customer is running Internet Explorer 7, they must allow RemoteCall’s “RCMain Control” 
ActiveX control to run.  
To check if this is disabled: 
1. From your browser window click “Tools > Manage Add-ons > Enable or Disable Add-ons” 

2. Select “Add-ons that have been used by Internet Explorer” from the “Show” menu 

3. Sort the list by “Publisher” and scroll down until you see “Rsupport Co., Ltd.” 

If it is disabled, click the name and select “Enable” from the “Settings” section and click “OK”. 

 
Note: Your browser should refresh automatically and the connection should initiate. 
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9.0 Contact Information and Technical Support 
 

Websites 
RemoteCall (www.remotecall.net) 

RSUPPORT (www.rsupport.com) 

 

E-mail 
info@rsupport.com 

sales@rsupport.com 

support@rsupport.com 

 

Phone 
+82 70-7011-0590 

 

Address 
2nd Floor Nano Bldg. 149-11 

Bangi-dong, Songpa-gu 

Seoul, Korea 

138-050 

 

*If you still have questions feel free to e-mail us at support@rsupport.com. 
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